VISUALIZING THE PATHOGENESIS OF THYROID EYE DISEASE:
AN EDUCATIONAL RESOURCE FOR UNDERSTANDING CURRENT
TREATMENT LIMITATIONS

by
Jacqueline Meyer

A thesis submitted to Johns Hopkins University in conformity
with the requirements for the degree of Master of Arts

Baltimore, Maryland
March 2014

© 2014 Jacqueline Meyer
All Rights Reserved
ABSTRACT

Thyroid eye disease (TED) describes a complex inflammatory condition that is commonly associated with, but not caused by, hyperthyroidism. It is often referred to as Graves’ Ophthalmopathy, Graves’ Orbitopathy, or Dysthyroid Orbitopathy. Affecting more than half of patients with hyperthyroidism (Graves’ Disease), it is the most common orbital disease in the United States. Chronic inflammation of the soft tissues in the eye socket yield a variety of symptoms, most of which are uncomfortable, noticeable, and disfiguring.

Every patient is affected differently, making the disease difficult to predict and treat. The most common symptom is eyelid retraction. Other clinical manifestations may include: eye redness, dry eye, excessive tearing, chemosis (swelling of the conjunctiva), periorbital edema (swelling of the soft tissue surrounding the orbit), pain and pressure behind the eye, proptosis (forward protrusion of the eyeball), and changes in vision. Due to limitations in knowledge of the disease and minimal clinical trials, there is no currently known effective method of treatment for the inflammation. Patients may suffer with these symptoms for up to several years before the inflammation subsides.

The majority of the educational resources available to patients and the general public are limited to text and photographs. Most of the existing illustrations only depict an anterior, external view of the common symptoms, lacking a comprehensive visual explanation of the disease. There is currently a need for improved educational material not only for patient education, but also to generate awareness and highlight the need for further research.

A Thyroid Eye Disease Center was recently established at the Wilmer Eye Institute’s Bethesda location. With multiple specialists working together to treat TED, optimal care is provided; however, they lack the educational material to effectively explain the disease to
their patients. To fill this need, an animation that summarizes TED along with an interactive module and 2D illustrations have been created.

Jacqueline Meyer

CHAIRPERSONS OF THE SUPERVISORY COMMITTEE

Faculty Advisor: Gary Lees, M.S., C.M.I., F.A.M.I.  
Chairman and Associate Professor  
Department of Art as Applied to Medicine  
The Johns Hopkins University School of Medicine

Thesis Preceptor: Shameema Sikder, M.D.  
Assistant Professor of Ophthalmology  
The Johns Hopkins University School of Medicine  
Medical Director  
The Wilmer Eye Institute at Bethesda

Content Experts: Prem Subramanian, M.D., Ph.D.  
Associate Professor of Ophthalmology  
The Johns Hopkins University School of Medicine  
Director, Thyroid Eye Disease Center  
The Wilmer Eye Institute at Bethesda

Nicholas Mahoney, M.D.  
Assistant Professor of Ophthalmology  
The Johns Hopkins University School of Medicine  
The Wilmer Eye Institute
ACKNOWLEDGEMENTS

I owe a tremendous amount of gratitude to my faculty advisor, Gary Lees, M.S., C.M.I., F.A.M.I., Chairman and Associate Professor of the Department of Art as Applied to Medicine, Johns Hopkins University School of Medicine. His knowledge and expertise in the field of medical illustration has been influential and inspiring over the past two years. I have very much appreciated his unwavering enthusiasm, encouragement and willingness to help.

I was privileged to work with three ophthalmologists from The Wilmer Eye Institute. Foremost, I would like to thank Shameema Sikder, M.D., Medical Director of the Wilmer Eye Institute at Bethesda and Assistant Professor in the Johns Hopkins University School of Medicine, who was the preceptor for this thesis. Her enthusiasm, positivity, guidance and expertise made the project possible. Dr. Sikder’s colleagues, Prem Subramanian, M.D., Ph.D., Director of the Thyroid Eye Disease Center in The Wilmer Eye Institute at Bethesda and Assistant Professor in the Johns Hopkins University School of Medicine, and Nicholas Mahoney, M.D., Assistant Professor in the Johns Hopkins University School of Medicine, were also incredibly responsive and helpful throughout this process. It was invaluable to receive feedback and assistance from three content experts with individual specialties.

The detailed measurements of ocular anatomy provided by Juan Garcia, M.A., C.C.A., Associate Professor in the Department of Art as Applied to Medicine, were crucial to the accuracy of the eye model. I would like to thank him for sharing his knowledge and providing feedback.
Jennifer Fairman, M.A., C.M.I., F.A.M.I. and Michael Linkinhoker, M.A., C.M.I.,
made the interactive component of the project possible with their helpful instruction of
Adobe Edge Animate and dependable assistance.

Thank you to Sarah Poynton, Ph.D., Associate Professor in The Johns Hopkins University
School of Medicine, for the assistance with scientific writing and to the Vesalius Trust for
their generosity in funding this project.

I would like to thank the entire Department of Art as Applied to Medicine faculty
and staff, especially Corinne Sandone, M.A., C.M.I., F.A.M.I. for her support and
encouragement as the newly appointed Director, as well as Dacia Balch for all she has
done to make my life easier.

To my classmates, James Abraham, Veronica Falconieri, Katelyn McDonald, Mike
Silver, Chris Smith, and Sam Welker, I am very grateful for the dependable source of
inspiration and support, and truly look forward to our continued friendship. I also thank
the Classes of 2013 and 2015.

Lastly, I would like to thank the talented Kristin McWharter and Aleksi Glick for their
contributions to the animation, as well as the rest of my friends and family for the endless
support, enthusiasm, and guidance.
# TABLE OF CONTENTS

Title Page ............................................................... i

Abstract .................................................................... ii

Acknowledgements .................................................... iv

Index of Figures ........................................................ viii

Introduction

Overview .................................................................... 1

Pathogenesis .............................................................. 2

Current limitations in Knowledge ................................ 4

Current limitations in Media and Subsequent Challenges .................................................................................. 4

Strategies for Effective Communication ................................ 5

Objectives .................................................................... 7

Materials and Methods

Research ..................................................................... 9

Animation: Thyroid Eye Disease .................................. 10

Planning ..................................................................... 10

Design and Creation of 2D Assets ................................. 10

Building the 3D Model ............................................... 12

Animating ................................................................... 18

3D: Cinema 4D .......................................................... 18

2D: After Effects ........................................................ 19

Illustration: Thyroid Eye Disease ................................. 22

Interactive: Thyroid Eye Disease: What Causes Double Vision? ................................................................. 22
Table of Contents

Results

Animation .................................................. 25
Illustration .................................................. 33
Interactive .................................................... 34
Access to Assets resulting from this thesis ................. 36

Discussion

Software ...................................................... 37
Technical Challenges ...................................... 38
Potential Improvement ..................................... 38

Conclusion .................................................. 40

Appendices .................................................. 42

References .................................................... 56

Vita .......................................................... 59
# INDEX OF FIGURES

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Pathogenesis of Thyroid Eye Disease</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>Positive Feedback Loop</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>Disease Activity vs. Severity Graph</td>
<td>5</td>
</tr>
<tr>
<td>4</td>
<td>Hierarchy of Visual Information</td>
<td>6</td>
</tr>
<tr>
<td>5</td>
<td>Color Palette and Font Choice</td>
<td>10</td>
</tr>
<tr>
<td>6</td>
<td>Thyroid Gland: Effects for Hyperthyroidism</td>
<td>11</td>
</tr>
<tr>
<td>7</td>
<td>Sagittal Orbit Illustration</td>
<td>11</td>
</tr>
<tr>
<td>8</td>
<td>Digital Paintings: Skin and Conjunctiva</td>
<td>12</td>
</tr>
<tr>
<td>9</td>
<td>Schematics of the Eyeball in Cross-Section</td>
<td>13</td>
</tr>
<tr>
<td>10</td>
<td>Modeling the Eyeball and Muscles: Primitives</td>
<td>13</td>
</tr>
<tr>
<td>11</td>
<td>Modeling the Muscles: HyperNURBS</td>
<td>14</td>
</tr>
<tr>
<td>12</td>
<td>Modeling the Eyelashes</td>
<td>15</td>
</tr>
<tr>
<td>13</td>
<td>Modeling the Skull</td>
<td>15</td>
</tr>
<tr>
<td>14</td>
<td>Creating a Texture Map with BodyPaint 3D</td>
<td>17</td>
</tr>
<tr>
<td>15</td>
<td>Projection Painting with BodyPaint 3D</td>
<td>17</td>
</tr>
<tr>
<td>16</td>
<td>Compositing and Masking in After Effects</td>
<td>19</td>
</tr>
<tr>
<td>17</td>
<td>After Effects: Stroke Effect</td>
<td>20</td>
</tr>
<tr>
<td>18</td>
<td>After Effects: Pen tool</td>
<td>22</td>
</tr>
<tr>
<td>19</td>
<td>Original Storyboards for Interactive</td>
<td>22</td>
</tr>
<tr>
<td>20</td>
<td>Edge Animate: Mouse Rollover</td>
<td>23</td>
</tr>
<tr>
<td>21</td>
<td>Edge Animate: Creating Actions</td>
<td>24</td>
</tr>
<tr>
<td>22</td>
<td>Edge Animate: Timeline</td>
<td>24</td>
</tr>
<tr>
<td>23</td>
<td>Animation: Title Screen</td>
<td>26</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Autoimmune Definition</td>
<td>26</td>
</tr>
<tr>
<td>--------</td>
<td>-------------------------------------------------------</td>
<td>----</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Immune System</td>
<td>26</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Correlation Between Hyperthyroidism and TED</td>
<td>27</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Bar Graph (TED)</td>
<td>27</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Bar Graph (Hyperthyroidism)</td>
<td>27</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: TED and Graves’ Disease Timeline</td>
<td>28</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Dots Infographic</td>
<td>28</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Demographic Statistic</td>
<td>28</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Demographic Silhouettes</td>
<td>29</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Morphing Letterforms</td>
<td>29</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Clinical Manifestation (symmetrical vs asymmetrical)</td>
<td>29</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Video Still</td>
<td>30</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Active Phase (graph)</td>
<td>30</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Blizzard Analogy</td>
<td>30</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Active Inflammation- Mild</td>
<td>31</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Active Inflammation- Severe</td>
<td>31</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Spontaneous Improvement</td>
<td>31</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Animated Graph- Active Phase</td>
<td>32</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Animated Graph- Inactive Phase</td>
<td>32</td>
</tr>
<tr>
<td>Figure</td>
<td>Animation: Ending</td>
<td>32</td>
</tr>
<tr>
<td>Figure</td>
<td>Illustration: Thyroid Eye Disease</td>
<td>33</td>
</tr>
<tr>
<td>Figure</td>
<td>Interactive: Compare Normal and Fibrotic Muscle</td>
<td>34</td>
</tr>
<tr>
<td>Figure</td>
<td>Interactive: Fibrotic Eye Movement Simulation</td>
<td>35</td>
</tr>
<tr>
<td>Figure</td>
<td>Interactive: Double Vision Simulation</td>
<td>35</td>
</tr>
</tbody>
</table>
INTRODUCTION

Overview

Thyroid eye disease (TED), also known as Dysthyroid Orbitopathy, Graves’ Orbitopathy, and Graves’ Ophthalmopathy, is the most common orbital disease in the United States, affecting an estimated 16 women and 3 men for every 100,000 people (Bahn, 2010). It is a serious and disfiguring condition that can lead to blindness in some patients. More than half of all patients diagnosed with hyperthyroidism (Graves’ disease) have TED (Gillespie, Smith, and Douglas, 2012). Despite this prevalence, online educational material for TED is almost exclusively limited to text and pictures. There are very few illustrations and even less didactic educational material.

The disease is highly variable, making it difficult to predict the severity and treat. Because the pathogenesis is not entirely understood, further research and clinical trials on current therapies are desperately needed (Sikder and Weinberg, 2009). Throughout the course of the disease symptoms are carefully monitored by specialists, but in the early stages there is little that can be done to provide relief. Patients become concerned and frustrated as they feel pressure behind their eyeball increase, their eyelids retract, and their eyes bulge out. Meanwhile their ophthalmologist cannot eliminate the inflammation. Patients with a moderate or severe stage experience higher levels of emotional side effects, including confusion, depression, and anger, than patients in a mild stage with less disfiguring symptoms (Farid, 2005). It is hypothesized that more effective education about the disease, clear explanation of treatment methods, and reassurance of recovery will help to reduce emotional and psychological distress by improving understanding of the disease.
Pathogenesis

TED is caused by an autoimmune condition, most commonly associated with hyperthyroidism, due to the thyrotropin receptor (TSHr) located on both orbital fibroblasts and thyroid follicle cells. During the autoimmune condition, the body systemically produces a thyroid-stimulating hormone receptor autoantibody (TSHr-Ab) that binds to the TSHr on the orbital fibroblasts and initiates a cascade resulting in adipogenesis and a deposition of hyaluronic acid and prostaglandins (Fig. 1). This causes increased adipose tissue, enlarged adipose and extraocular muscle volume, and fibrosis. Blindness is a concern when the muscles compress the optic nerve due to increased volume in the orbit and also when the cornea ulcerates due to prolonged exposure. (Bahn, 2010)
Clinical symptoms may include: eyelid retraction, dry eyes, excessive tearing, chemosis (swelling of the conjunctiva), periorbital edema (swelling of tissues surrounding the orbit), pain or pressure in the orbit, and proptosis (anterior bulging of the eye). Eyelid retraction can be caused by overstimulation of the Muller’s muscle or a swollen superior rectus muscle crowding the levator palpebrae muscle, and results in corneal exposure, which in turn causes dry eye. Increased tissue volume in the orbit can compress vasculature causing decreased venous and lymphatic drainage, which in turn may cause chemosis and periorbital edema. (Bahn, 2003)

A positive feedback loop is present during adipogenic conditions (Fig. 2) (Bahn, 2003). The duration of this active inflammatory phase is variable and unpredictable, lasting on average between six to 24 months (Gillespie, Smith, and Douglas, 2012). While 30 percent of patients spontaneously improve during a mild stage and never progress to a moderate or severe stage (Wiersinga, 2012), 80 percent of those that do progress to a moderate or severe stage experience more disfiguring symptoms and will need surgical rehabilitation after the disease becomes inactive (Gillespie, Smith, and Douglas, 2012).

Fig. 2 Positive feedback loop, adapted from Bahn (2003)
Current Limitations in Knowledge

Although much is known about the pathogenesis, it remains unclear why the disease affects some patients severely while others show no symptoms. The duration, regardless of the severity, is also unpredictable. Additionally, TED can present with hypothyroidism and in rare cases a normally functioning thyroid, or euthyroidism (Bahn, 2010).

Limitations in the scientific understanding of TED present a challenge for specialists caring for patients and designing treatment plans. Some symptoms can be temporarily alleviated during the inflammatory phase, but there is currently no treatment for the active inflammation. Patients with a mild stage can be prescribed eye drops, ointment, and prism glasses and patients with a moderate to severe stage can be given corticosteroids. Surgical intervention is reserved for the inactive post-inflammatory phase, unless vision loss is a severe threat (Gillespie, Smith, and Douglas, 2012). Further research and more clinical trials are imperative to improve understanding of the pathogenesis and pathophysiology and thus improve approaches used to treat the disease (Sikder and Weinberg, 2009).

Current Limitations in Media and Subsequent Challenges

There are several websites dedicated to TED, most of which provide thorough information, but do not offer visual explanations of the disease other than photographs. Animation, illustrations, and interactive media will greatly enhance patient and public understanding and awareness.
Current challenges for patients include comprehension of:

1. Where he/she is on the curve denoting the phase and severity
   (Dr. Mahoney’s graph of disease Activity vs Severity, Fig. 3)

2. What his/her ophthalmologist is waiting for and why they are
   not more proactive during the early stages of the disease

3. Why it is important to routinely schedule appointments when
   no action is being taken

4. The concept of inflammation causing fibrosis

5. The anatomy changed during surgery

---

**Fig. 3** Graph developed by Dr. Mahoney explaining the course of the disease. The curves represent the relationship between the degree of active inflammation and the consequential severity of clinical manifestation.

---

**Strategies for Effective Communication**

A 2D animation was determined to be an appropriate modality for patient education, with simple illustrations, graphics, and text that limit the amount of visual information and allow the viewer to focus on key points without extraneous detail.
The hierarchy of information is as follows:

1. Most significant, a 3D model shows changes to the eye and surrounding tissues in accurate proportions and perspective. Digitally painted 2D overlays incorporate the model into the aesthetic of the animation.

2. The thyroid gland, digitally painted, has an appearance aesthetically similar to the eye.

3. Supporting visuals, like the immune system, silhouettes, and blizzard scene, are simplified to flat color vector images with minimal detail.

Fig. 4 Hierarchy of visual information

The use of metaphors and analogies in scientific education has been extensively debated; however, studies (with a constructivist perspective) have shown improved cognition in test groups when presented new material in the form of a metaphor or analogy versus no metaphor or analogy. The argument is that the use of metaphors and analogies should be cautioned due to the potential for misinterpretation caused by flaws in the comparison. Therefore, careful considerations are imperative to developing an effective metaphor or analogy. (Glynn and Takahashi, 1998)

An analogy was developed for the active inflammatory phase of TED. After consultation with the content experts, it was determined that this would be a helpful tool for patients by providing an alternative way of thinking about the disease. To avoid
unwanted misunderstanding, the comparisons were clearly stated and the analogy was not overly emphasized.

**Objectives**

Based on discussion with all three content experts the following objectives were established:

1. To provide a general overview of the disease for patients/lay audience as well as potential referring general practitioners
   a. depict stages of the disease and emphasize potential severity
   b. enable understanding of the difference between the active inflammatory phase and inactive post-inflammatory phase
   c. provide reasoning for the method of care

2. To spread awareness of the disease and the need for further research and clinical trials

3. A comprehensive educational module will:
   a. educate patients by helping them to better understand what is happening and why
   b. alleviate emotional and psychological distress induced by a lack of understanding
   c. inform general practitioners and ophthalmologists of the
disease and how it may present

d. highlight the importance of proper care by specialists

e. spread awareness of the disease

Information will be delivered in a variety of ways to accommodate for different learning styles, including:

1. Animation

2. 2D illustrations (handout)

3. Interactive module
MATERIALS AND METHODS

Research

Existing educational websites were explored to establish a sense of the amount, quality, and accessibility of information currently available to the public. Peer-reviewed research was then gathered through open-access journal articles available online. A slide presentation created by the three content experts containing information, statistics and photographs was also a valuable reference. Data gathered from all sources was compiled into flowcharts and diagrams as a form of note-taking to enable better comprehension of the complex disease (Appendix A). Following the peer-reviewed literature searches, educational websites were revisited to compare the amount and accuracy of information.

Common questions and concerns of patients were identified by the content experts, enabling clear objectives for a comprehensive educational module to be established. A flowchart for a website was created and approved by the content experts (Appendix B). Using the flowchart, basic webpage layouts were designed (Appendix C).

The animation was determined to be the priority for the website, because it was designed to provide a summary of TED: the pathogenesis, who is affected, and current treatment methods. The interactive symptoms module was secondary. Misalignment was the only one of the three planned topics (Misalignment, Proptosis, and Vision Loss) that was brought to full completion.
Animation: Thyroid Eye Disease

Planning

A narration was drafted based on the stated objectives. Following a review by the faculty advisor, rough storyboards were developed. The narration and storyboards were then reviewed, edited, and approved by the content experts (Appendix D). Providing rough storyboards early in the process enabled the content experts to better understand and comment on the overall plan, not just the narration.

The storyboards were modified to accommodate minor narrative edits (Appendix E). The narration was recorded and an animatic was developed using the existing storyboards.

An animatic is an effective and efficient method of timing the narration to the amount of planned visual content. This enabled the content experts to provide feedback in the early stages when changes could easily be made.

Design and Creation of 2D Assets

A flat, clean looking style was chosen to simplify the information for a lay audience, allowing the viewer to focus on the overall concept and important points (Fig. 5). For example, a generic silhouette highlights where the thyroid is located without including distracting details, such as a face.

![Image of thyroid and color wheel]

Fig 5. A cool and bright palette was chosen. Throughout the animation, the purple represents TED and the red-orange represents hyperthyroidism. Nimbus Sans and Nimbus Sans Condensed were the typefaces selected, demonstrated respectively at 10 pt.
Originally the silhouette had been drawn in Adobe Illustrator®, but Adobe After Effects® only enables depth to be added to shape and text layers. Therefore, the silhouette was traced with the pen tool, creating a new shape layer that would allow depth to be extruded in 3D. The other silhouettes and vector art, which would remain 2D, were created in Illustrator.

The thyroid gland was painted in Adobe Photoshop®. After importing into After Effects, the CC Plastic effect was applied, which allows significantly more setting controls than its Photoshop equivalent, ‘plastic wrap’. A Glow effect was also added in After Effects to symbolize when the thyroid was hyperactive versus normal (Fig. 6).

Initially a sagittal view of the eye and orbit was chosen to show the expansion of the soft tissues (Fig. 7); however, it was noted that most patients have difficulty understanding
a sagittal view. Therefore, a three-quarters view was determined to be more comprehensible for a lay audience, enabling both the muscle inflammation and the external symptoms to be shown together. The intraconal and extraconal fat was omitted for clarity. A 3D model was chosen as the medium to ensure accurate proportions of the eye and muscles in perspective. Digitally painted overlays for the 3D eye and skull include: beginning and end stage skin; beginning, middle and end stage redness and chemosis, and an additional severe chemosis layer (Fig. 8).

Fig. 8  Paintings overlay 3D model to animate the redness and chemosis.

Building the 3D model

Modeling: the eye

Precise dimensions were obtained and used to create schematics of a superior and sagittal view of the eye, optic nerve, and muscle attachments in Illustrator (Fig. 9). Jpegs of the superior and sagittal schematics were imported into Cinema 4D® (C4D), in the four panel view: Options > Configure > Back > Image. This placed the images in the background of the file, creating a blueprint for the 3D model.
The eyeball was modeled first, using point manipulation of primitive objects made editable (Fig. 10). Deformers were experimented with but determined to be less precise than point manipulation.

Fig. 10 Primitive cubes scaled to precise muscle measurements using imported jpg
Materials & Methods

Modeling: the muscles

Cubes were measured to correct dimensions, placed into HyperNURBs and further modeled to achieve an accurate shape (Fig. 11).

![Fig. 11 Cubes arranged on eyeball and modeled with weighted hyperNURBS](image)

Modeling: the skin

A cube was modified, placed into a HyperNURB, and modeled to fit around the eyeball. The cyclashes were created using a circle spline and an arc spline in a Sweep NURBS (Fig. 12). The end scale was set to 0% to create a taper. The eyelash was duplicated twice. The three lashes were placed in a MoGraph Cloner and mapped onto a new spline that would be positioned just inside the edge of the eyelid (via Cloner > Object > Object: Spline) to create the three rows of lashes. The Fix Clone and Align Clone settings were selected to correctly map the cloned objects directly onto the spline and control position. Activation of these settings also prevented random movement of the individual clones during animation of the spline. The original three lashes were rotated slightly, all in different directions to achieve a more natural look.
Materials & Methods

Fig. 12 The eyelashes were made using an arc spline and circle spline, Sweep NURBS, a cloner, and mapped onto two additional splines.

Modeling: the skull

An existing model was used. The skull had previously been derived from a DICOM data set, exported from OsiriX® and repaired in ZBrush®. The high-poly ZBrush model was saved as an obj, imported into C4D, decimated using the Polygon Reduction deformer, and trimmed to only included necessary information (Fig. 13). Repurposing this model saved a lot of time.

Fig. 13 The original skull was cropped (left) and reduced in resolution (right) with the Polygon Reduction deformer in C4D.
Materials

New materials were developed for the optic nerve, sclera, cornea, skin and eyelashes. The sandstone preset was edited to represent bone. The materials for the muscles and iris were painted using 3D BodyPaint®.

3D BodyPaint is a tool in C4D that enables custom UV mapping of any aspect of a material. To create convincing muscle fading into tendon, texture maps for the color channel and alpha channel were created.

Custom texture maps for each muscle were necessary because the muscles have unique proportions, and therefore unique meshes. To create a texture map, the layout was set to BP UV Edit and the object to be painted was selected in the objects panel. A new material was created and then activated in the materials panel by clicking the red X. The UV mesh for the selected object was made visible by going to UV Mesh > Show UV Mesh in the BP UV Edit panel. Under UV Mapping, the projection with no overlapping geometry was chosen. A new texture was created, saved, and applied to the color channel in the materials editor (Fig. 14). The BodyPaint 3D Setup Wizard can also be used to complete these steps.

With the 3D Painting Mode enabled and the brush tool selected, the texture could then be painted directly on the model or on the UV map. To the paint muscle and tendon it was most effective to use a soft brush and paint directly onto the model.

In order to create the illusion of tendon blending into sclera, an alpha channel texture map was painted. This created a gradation to transparency in the material at the attachment point of the tendon. The method to create the alpha texture map was the same as with the color texture map. The map was painted in grayscale to represent opacity and
applied to the alpha channel of the material.

Fig. 14. Materials, Attributes, and UV Mapping settings used to create a texture map for the color channel. Cubic or Cubic 2 was typically the best projection.

Fig. 15 Projection painting with a photograph
Initially the iris was painted using this same method (in the color channel), but after discovering projection painting, a photograph was used to achieve a more realistic looking iris. A high-resolution photograph was imported into C4D and projected onto the iris object. The image needed to be distorted slightly, using the Transform Bitmap tool. Once accurately mapped, it was fixed to the UV map by generating UV coordinates (in the texture tag). The image is projected from the perspective in the viewport (Fig. 15). Rotating or zooming in the viewport will change the way the image is mapped onto the object. Therefore, UV coordinates must be generated before doing anything else.

**Animating**

**3D: Cinema 4D**

Proptosis was animated by keyframing the position and rotation of the eyeball. Muscle enlargement and eyelid retraction were achieved with point level animation. Because the objects remained low-poly muscle in a HyperNURB, the number of points was manageable. To keyframe object points, the Point Level Animation button was turned on. Experimentation using primitive objects resulted in the conclusion that deformer tools (ie. Bulge, FFD, etc) were less effective to animate the muscle enlargement. FFD was the most effective and time efficient, but was difficult to maintain precise control over location of tendons.

The skull, eyeball/muscles, and skin were all rendered out separately using alpha channels and saved as png sequences with transparent backgrounds to allow flexible layering and masking in After Effects.
2D: After Effects

To animate the progression of TED, layer masks and Puppet Pin were essential tools. The layers were stacked so that transparency could be achieved by masking the top layer, giving it the illusion of being underneath (Fig. 16). The redness/chemosis and skin layers were animated with the puppet pin tool to create smooth transitions.

Fig. 16 The eye layer is placed above the skull layer and masked to create the illusion that the skull is translucent

The animation was organized into different compositions, or precompositions, and then nested into a main composition. Advantages of using nested compositions included: the ability to group and manage layers, easily reuse and edit segments of animation, and reduced render time by disabling the 3D Ray-traced Render setting when possible. All aspects of the animation involving precisely timed text to narration were kept in the main
composition with the audio file.

To achieve precisely timed text, the exact locations of words were determined by scrubbing through the timeline panel while holding down Command (or Control). More effective than a RAM preview, this method plays the narration at a desired pace instead of in real time.

The 3D feature of After Effects was enabled, allowing any layer to be manipulated in X, Y, and Z coordinates by simply clicking its 3D toggle button and editing the position coordinates. Only the selected layers will exist in 3D space, keeping unselected layers in the default 2D view. Raytraced 3D rendering was enabled in the composition settings to allow objects (ie. the silhouette and bar graph) to be given depth.

Two repeaters were used to create the array of dots out of a single circle. The 16 pink dots and 3 blue dots are all individual shapes keyframed to fade on separately. The ampersand that connects the dots was created using a mask. The mask was made in Illustrator and applied to a solid shape layer. Effect > Generate > Stroke was applied to the shape layer.

![Fig. 17 Stroke effect applied to solid shape layer with mask (yellow lines).]
The brush size set at 5.6, the paint style set to “On Transparent” and with “Start” animated from 100% to 0%, an illusion was created that the lines draw themselves to connect the colored dots. (Fig. 17)

A video clip was included to show ophthalmologist-patient interaction and emphasize the importance of routine appointments and monitoring. The video was shot with a Cannon EOS 70D®. Footage was edited in a new After Effects file, exported as a Quicktime® file without sound, and imported into the main animation composition. Little editing was needed.

The blizzard scene was created using a snow simulation. A new shape layer was added and Effect > Simulation > CC Snowfall was applied. The number of flakes, size, speed, wind, and variation settings were changed and keyframed to create desired effects. A mask was applied to the layer, limiting snowfall during the second scene when it appears as an inset.

The pen tool was used to create the a and b in “unpredictable” that morph into the linear eye graphic. The letterforms were created to mimic the typeface in as few points as possible for easy manipulation and smooth transitioning (Fig. 18). The stroke of the lines was set to match the rest of the letterforms and the paths of the lines were keyframed to create the metamorphosis. The Create Shapes from Text function, which is the equivalent of “creating outlines” in Illustrator, could have been used to make the letterforms, but would have made too many points and have been difficult to animate. Create Shapes from Text was, however, used to manipulate the T in the title of the animation.
Fig. 18 The path points were keyframed to create the morphing letterforms.

Illustration: Thyroid Eye Disease

The stages illustrations were created using assets from the animation, with some additional painting to emphasize key features of each stage. Labels and brief word story were added. The insets for Inflammation/Fibrosis and Optic Neuropathy were created in Illustrator and Photoshop to address important concepts not explained or depicted in the animation.

Interactive: Thyroid Eye Disease: What Causes Double Vision?

The interactive component was originally designed to include all major symptoms, but after storyboards were shared with the preceptor, it was decided that only three topics were necessary to include: bulging eyes, misalignment, and vision loss (Fig. 19).

Fig. 19 Original storyboards for interactive.
The interactive component was determined to be completed, time permitting. Misalignment was brought to full completion.

**Content**

Base artwork was created in Illustrator and layers were imported into Adobe Edge Animate® as png files. Text and button shapes were added to the layout in Edge Animate.

**Actions**

Actions were assigned to objects to create interactivity. Mouse rollover states were changed to indicate to the user when an object is clickable. The standard pointer was chosen (Fig. 20).

![Image](image.png)

Fig. 20 The cursor setting in the Properties panel was used to indicate when an object is clickable.

To create buttons, shapes and text were grouped as a symbol. In the actions panel for the symbol, the ‘click’ state was edited. The action attributed to the click state was set to target a specific starting point for the animation and initiate play. A toggle button was needed to hide/show normal anatomy and hide/show double vision information. These were created using conditional statements that identify and play the opposite of the current state of the target (position and visibility) (Fig. 21).
Fig. 21 JavaScript code for basic commands, located on the right, were selected and edited to create actions for specific symbols.

**Animating**

The stage and timeline look very similar to After Effects, but in addition to keyframing; ‘triggers’, ‘labels’, and ‘actions’ need to be set. Start and stop triggers and labels applied to the timeline indicate the location and duration of the animation that is targeted by the action. Multiple clips were set to start and stop within a single timeline, so that artwork could be reused (Fig. 22).

Fig. 22 In this example, each animation segment represents a different movement of the eye, denoted by the labels. Each animation is sandwiched between a play trigger and a stop trigger, so that only the segment of timeline targeted by the corresponding action plays and then stops.

Instead of rendering the final animations, the entire project needed to be published as an OAM, which packages all assets and code together and allows it to be uploaded to a target directory.
RESULTS

Animation

The animation incorporates both 2D and 3D elements to provide an overview of TED: the cause of inflammation, course of the disease, who is affected, and how it is treated. Various levels of information accommodate a wide audience, including general physicians who may be unfamiliar with the disease.

The animation begins: *Thyroid eye disease, also known as TED is an autoimmune disease that causes inflammation of the soft tissues in the eye socket* (Fig. 23). This initial statement is followed by a brief description of what an autoimmune disease is and why a condition that affects the thyroid gland might also affect the eye. A basic explanation is included for a lay audience, while specific protein structures are labeled for a medical or scientific audience. (Figs. 24-26). The correlation between hyperthyroidism and TED is explained (Figs. 27-29).

Now that an overview of what TED is has been established, the demographic is addressed. (Figs. 30-32). Outcomes of the disease are addressed and a video clip is included to emphasize the importance of regularly seeing an ophthalmologist to adequately monitor the disease (Figs. 33-35).

The disease activity is subsequently explained and the analogy is introduced (Figs. 36-40). The graph animates to explain the course of the disease (Activity vs Severity) (Fig. 41-42). The animation ends reassuringly: *Typically a normal appearance can be restored and re-occurrences of TED are rare* (Fig. 43).
Autoimmune Disease:
the body’s immune system
attacks healthy par

Fig. 23

Fig. 24

Fig. 25
Results

TED

years before or

Graves’ disease

Fig. 29

Fig. 30

Fig. 31
Results

Fig. 35

Blurred vision
Loss of peripheral vision
Impaired color vision
Double vision
Blindness

Fig. 36

Fig. 37
Results

Fig. 38

Fig. 39

Fig. 40
Fig. 44  An overview of the disease is illustrated, highlighting potential severity. Insets are included to depict the significance of fibrosis and optic neuropathy. A link to the website containing the animation and interactive is included at the bottom.
Interactive

The interactive allows the user to see what causes misalignment (strabismus) and double vision. The user can compare a normal muscle with a fibrotic muscle by clicking the “Show Normal” tab (Fig. 45), discover the limited motility of a severely affected eye with the eye movement simulation (Fig. 46), and View a double vision simulation (Fig. 47).
Fig. 46

Fig. 47
Asset Referral Page

Access to the animation and interactive resulting from this thesis is available at

www.hopkinsmedicine.org/wilmer/services/thyroid_eye_disease.

The handout with 2D illustrations is available at the Wilmer Eye Institute in Bethesda or by contacting the author through the Department of Art as Applied to Medicine, via

www.hopkinsmedicine.org/medart.
DISCUSSION

Software

Cinema 4D

Cinema 4D (C4D) was the software of choice for both modeling and animating eyelid retraction, EOM enlargement and proptosis. C4D is a useful program for modeling geometric forms with tools and features that made it easy to build the eye to exact specifications. Using tools such as the cloner and HyperNURBS, everything was built efficiently, allowing easy control during animation, and a quick render time.

After Effects

After Effects was used to compile the 3D animation layers, add transparencies, edit video, animate digital paintings, add typography and create motion graphics. Using the 3D Ray-traced render setting was an effective way to simulate a 3D space while maintaining a graphic 2D aesthetic. Other important features include the graph editor, used frequently to control easing and troubleshoot jumpy or unwanted movement, as well as time-remapping and time-reverse layer, which were crucial in manipulating the nested compositions within the main composition.

Edge Animate

Edge Animate is a quick and user-friendly way to create a HTML5, CSS, and JavaScript driven interactive. However, it is still in its infancy and has received criticism in the professional design world for its limitations in drawing and design tools. To work around its limitations, all artwork was created in Illustrator and imported. The advantages of using

37
this program are that HTML5 does not require a plugin like Flash does, animation features are better than Flash, and very little coding knowledge is required to create a web-based interactive. Edge Animate was sufficient for this project and with continued improvement by Adobe has the potential to be a very powerful software.

**Technical Challenges**

After Effects was not originally designed as a 3D program. Due to the 3D Ray-traced render setting, amount of layers with masks, and effects/simulations, the program slowed down and render time drastically increased. To make workflow more efficient the preview resolution was reduced and the RAM cache was purged periodically (Edit > Purge).

To improve render time, nested compositions were pre-rendered (Composition > Pre-render). The default AVI format and settings were accepted. There is no way to directly undo pre-rendering, but the original nested composition is preserved and can be used to replace the pre-rendered AVI in the timeline panel. However, because keyframes and time-remapping would need to be reapplied each time the composition was changed, a second copy of the file was saved for continued editing.

**Potential Improvement**

Although elements of the original design were produced, the full website was not completed. The work that was created will be featured on the Wilmer website. While this is a benefit for the newly established thyroid eye disease center and its patients, putting the content on an established webpage limits the control over presentation. It may be more effective to have
the content exist on a multi-page website exclusively dedicated to TED. Ideally, illustrations depicting surgical rehabilitation methods would be included, as originally proposed, to provide a complete overview.

Adding more interactive content may be beneficial to engage users and generate interest and awareness. The interactive created as part of this thesis could be expanded to include all three of the proposed topics. Additional elements, such as quizzes could also be used to engage the user, improve retention of the information, and monitor efficacy of the provided material.
CONCLUSION

The body of work produced for this master’s thesis translates a complex medical condition into comprehensible educational material consisting of: an animation, online interactive, and 2D illustrations. All aspects of the work were designed to address common questions and concerns patients have due to the previous lack of medical visuals. This work has the potential to improve communication between patients and ophthalmologists, who previously discussed the condition without any didactic educational material.

The graph of Disease Activity versus Severity (Fig. 3), which had been used with patients, was featured and expanded upon. Animation of the lines and use of color highlight patient variability and emphasize the relationship between disease activity/severity, the inflammatory phase/post-inflammatory phase, and the appropriate time for surgical rehabilitation. The moving graph, more comprehensive than a static image, was one of the elements used to accomplish objective 1:

a. depict stages of the disease and emphasize potential severity

b. enable understanding of the difference between the active inflammatory phase and inactive post-inflammatory phase

c. provide reasoning for the method of care

Scientific information, such as specific protein names, was included to educate medical professionals who may be unfamiliar with thyroid eye disease and accomplish objective 2: to spread awareness of the disease and the need for further research and clinical trials.

Designing for patients as well as a more scientifically-literate audience required a balance between simplification of information and the amount of content. It was a goal to include enough information to educate any viewer and generate interest and awareness of the disease.
The amount of both general and specific information provides a thorough overview of TED. Presenting the information in a variety of forms, with an animation, interactive, and 2D illustrations, engages the viewer and will:

a. educate patients by helping them to better understand what is happening and why
b. alleviate emotional and psychological distress induced by a lack of understanding
c. inform general practitioners and ophthalmologists of the disease and how it may present
d. highlight the importance of proper care by specialists
e. spread awareness of the disease

The educational material produced will be used by a newly established and uniquely specialized Thyroid Eye Disease Center at the Wilmer Eye Institute’s satellite location in Bethesda, Maryland. The animation, illustrations and interactive will be made publicly available on the Wilmer website (www.hopkinsmedicine.org/wilmer/services/thyroid-eye-disease) and the 2D illustration will be available as a printed resource in the clinic.
Animation
(like Pancreatic Cancer site: http://pathology.jhu.edu/pancess/wu/index.html)

I think an infographic approach (like the second pancreatic cancer video) will be most appropriate. It presents the information clearly and allows the viewer to read as well as listen—good for basic info and statistics.

Interactive (stages)
(like the glaucoma example, Dr. Sikder)
The user can click on icons or move a sliding bar to visually transition from a mild stage to a severe stage and easily compare the pathology to the normal.

This can be designed primarily for patients to understand what is causing their symptoms, or for physicians to understand the CAS or VISA classification systems.

Illustrations
This can be kept simple to teach a lay audience the basic concept of what is changed during the procedure and why. If for physicians, I would illustrate it step-by-step in more detail.

Basic flowchart
Some of the information, such as the pathogenesis and surgical interventions, needs to be addressed differently for a physician rather than a patient/lay audience.

One solution could be having an option on the home page to select either 'patient' or 'physician' and all proceeding info would be relevant to the user. Another solution would be to design everything for patients/lay audience and include additional info for physicians at the bottom of the page or as a link from each page.
APPENDIX C

Webpage Layouts

TREATMENT

RESOURCES

SYMPTOMS

GLOSSARY

WEBPAGE LAYOUTS
Light grey boxes indicate text.
The videos could be of Dr. Mahoney, Dr. Suhramanian, and/or Dr. Gire.
APPENDIX D

Animation Narration

Thyroid eye disease, also known as TED, is an autoimmune disease that causes inflammation of the soft tissues in the eye socket. In autoimmune diseases, the body’s immune system attacks healthy parts of the body by mistake. When antibodies attack the thyroid gland, the thyroid becomes hyperactive. These antibodies also may attack tissues in the eye socket that surround the eyeball because the thyroid and the eye socket tissues share some protein structures.

More than half of patients with high thyroid levels have TED, but nearly all patients with TED have or will develop hyperthyroidism, also known as Graves’ Disease. The onset of TED usually occurs at the same time or within 18 months of Graves’ disease, but in some cases will present years before or afterwards. Treatments for hyperthyroidism do not affect TED. The thyroid gland and the eye condition need to be addressed individually by specialists.

It is estimated that 16 women and 3 men out of every 100,000 people in the US suffer from TED. People of all ages can get TED, but usually not before adolescence. A variety of factors affect the onset, duration, and severity of TED including genetics, gender, thyroid function and smoking.

TED is a very complex and unpredictable disease. Typically both eyes are affected, but they are not always affected equally. In fact, TED may affect only one eye. Untreated TED sometimes leads to blindness, but ophthalmology specialists can prevent the most severe consequences of the disease and will work with patients to monitor and effectively treat all aspects of TED.
There are two phases of TED: an active phase and an inactive phase. You can think of it like a blizzard. The storm is like the active phase when the inflammation is building up. You would not start shoveling immediately because you know the snow will keep accumulating. It can be hard to predict how much snow you will get and when it will stop. Some of the snow may even melt away on its own after the storm. All you can do is monitor it and be patient.

During the active phase, treatment such as eye drops, ointment, and prism glasses can alleviate some discomfort, but premature surgery would be like shoveling the snow too early. However, it is critical to continue routine check-ups with your ophthalmologist because the duration and severity of the inflammation is different for everybody and urgent treatment may still be needed if you start losing vision.

The active phase typically lasts for six to 24 months. The inactive phase is declared after clinical signs have plateaued and remained stable for six months. This is when surgical rehabilitation should be considered. 80 percent of patients will need surgery after the disease becomes inactive. Although some patients may be left with minor effects of the disease, including weakened muscle function, typically a normal appearance can be restored and re-occurrences of TED are rare.
Thyroid Eye Disease, also known as TED, is an autoimmune disease that causes inflammation of the soft tissues in the eye socket.

Text fades on: the arrow draws itself

When antibodies attack the thyroid gland

Antibody and thyroid fade on

Definition types itself

Camera zooms and spins around 3D silhouette

Camera frames silhouette, ‘Immune System’ fades on

the thyroid becomes

Camera stops at side of silhouette
Hyperactive.

These antibodies also may attack tissues in the eye socket that surround the eyeball.

because the thyroid and the eye socket tissues

Negative spaces on the sides frame “Hyperactive,” crossfade

Sagittal view of orbit appears with representation of WBC infiltration

Split screen compares antibody’s effect on thyroid and orbital tissues

share some protein structures.

More than half of patients with high thyroid levels have TED,

but nearly all patients with TED have or will develop

Shared protein structures fade on crossfade to bar graph

Silhouette and bar spin to opposite sides
Hyperthyroidism, also known as Graves' Disease.

"Hyperthyroidism" fades on, followed by "Graves' Disease"

or within 18 months of Graves' disease,

The onset of TED

Calendar fades on

but in some cases will present years before or afterwards.

Graves' Disease

Calendar duplicates

TED calendar pages spread out

18 pages line up

Treatments for hyperthyroidism do not affect TED.

Crossfade to split screen
The thyroid gland and the eye condition need to be addressed individually by specialists.

It is estimated that 16 women and 3 men out of every 100,000 people in the US suffer from TED.

Array of dots fades on. 16 turn pink, 3 turn blue, camera zoom out

A variety of factors affect the onset, duration, and severity of TED including genetics, gender, thyroid function and smoking.

People of all ages can get TED, but usually not before adolescence.

Crossfade to silhouettes, pre-adolescent figures fade to 50% opacity

Pan camera

Camera frames stacked text
TED is a very complex and unpredictable disease. Typically both eyes are affected.

Text swings out of the way

"Complex & Unpredictable appear"

Camera zooms in on a and b of unpredictable

a and b morph into 'eyes'

but they are not always affected equally. In fact, TED may affect only one eye.

Screen fades to black

Untreated TED sometimes leads to blindness,

but ophthalmology specialists can prevent the most severe consequences of the disease and will work with patients to monitor and effectively treat all aspects of TED.

Scene fades on. Eye chart used to show vision changes.
There are two phases of TED: an active phase and an inactive phase.

Eye chart flips around to show graph

You can think of it like a blizzard. The storm is like the active phase when the inflammation is building up.

Camera zoom on graph; graph becomes blizzard scene

You would not start shoveling immediately because you know the snow will keep accumulating.

Split-screen fades on: snow accumulation on left, inflammation on right

It can be hard to predict how much snow you will get and when it will stop.

Some of the snow may even melt away on its own after the storm. All you can do is monitor it and be patient.

During the active phase, treatment such as eye drops... However, it is critical to continue routine check-ups with your ophthalmologist

Layers of snow fade on, eye severity animates

Text fades on sequentially; lines draw themselves
because the duration and severity of the inflammation is different for everybody and urgent treatment may still be needed if you start losing vision.

Graph draws itself

Lines move to show variation

The active phase typically lasts for six to 24 months.

The inactive phase is declared after clinical signs have plateaued and remained stable for six months. This is when surgical rehabilitation should be considered.

Crossfade

Graph grows to show inactive phase
80 percent of patients will need surgery after the disease becomes inactive.

Although some patients may be left with minor effects of the disease, including weakened muscle function,

camera pans down to ‘80%’

80% spins 90 degrees

text appears

typically a normal appearance can be restored

and re-occurrences of TED are rare.

severe eye animates to normal
# APPENDIX F

## Hardware & Software

### Hardware

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computers</td>
<td><strong>Apple iMac® 27’’</strong> with 3.4 GHz Intel Core i7 8GB RAM</td>
</tr>
<tr>
<td></td>
<td><strong>Dell® 27’’ 4th Generation Intel® Core™ i7 processor 16 GB RAM</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Apple MacBook Pro® 13’’</strong> with 2.4 GHx Intel Core 2 Duo 4GB RAM</td>
</tr>
<tr>
<td>Tablet</td>
<td><strong>Wacom Intuous®</strong> 2 6”x8” graphics tablet</td>
</tr>
<tr>
<td>Scanner</td>
<td><strong>Microtek®: ScanMaker 9800XL scanner</strong></td>
</tr>
<tr>
<td>File Storage</td>
<td><strong>WD® My Passport</strong> 1 TB USB 3.0 External Hard Drive</td>
</tr>
<tr>
<td></td>
<td><strong>Sandisk® 16GB Cruzer</strong> USB 2.0 Hi Speed Flash Memory Drive</td>
</tr>
<tr>
<td>Printer</td>
<td><strong>Epson® 3880 Design Edition Inkjet printer</strong></td>
</tr>
<tr>
<td>Audio and Video</td>
<td><strong>MXL 2001 Large Diaphragm Condenser Mic</strong>, 30Hz-20kHz</td>
</tr>
<tr>
<td></td>
<td><strong>Apogee One Single-channel USB Audio Interface</strong>, 24-bit/48kHz</td>
</tr>
<tr>
<td></td>
<td><strong>Canon EOS 70D DSLR</strong>, 20.2 MP, Full HD 1080p video</td>
</tr>
</tbody>
</table>

### Software

**Adobe® Creative Suite**
- After Effects CC
- Audition CC
- Edge Animate CC
- Illustrator CC
- InDesign CC
- Photoshop CC

**Maxon® Cinema 4D**
REFERENCES

Cited References


General References


Sikder, S., P. Subramanian, and N. Mahoney. 2013. “Update on Thyroid Eye Disease.” Powerpoint from presention at Grand Rounds at The Johns Hopkins Hospital, Baltimore, MD.

“Thyroid Eye Disease.” *Cleveland Clinic.*


VITA

Jacqueline Meyer was born on February 14, 1990 and grew up in the small town of Titusville, NJ. After graduating high school, she moved to Baltimore to attend the Maryland Institute College of Art (MICA). She pursued a Bachelor of Fine Arts in Drawing, with a concentrated study in Graphic Design. During the spring semester of her Sophomore year, she interned with Joy Marlowe, M.A. C.M.I., at the Rubin Institute for Advanced Orthopedics at Sinai Hospital. This was her first experience with medical illustration, as well as her first opportunity to observe in surgery. In further preparation for graduate school, Jackie studied anatomy, biology, and chemistry at local universities and graduated MICA in May of 2012.

In August 2012, she joined the Department of Art as Applied to Medicine in The Johns Hopkins University School of Medicine. Her poster, Lifecycle of the Moon Jelly (Aurelia aurita) received an award of merit at the Association of Medical Illustrators Annual Juried Salon in July 2013 and in March 2014 she received a research grant from the Vesalius Trust for her thesis work. Jackie will receive her Master of Arts in Medical and Biological Illustration in May 2014.